Welcome to the Year End Information Session

April 2017
Agenda

Rita Carlo
• Website information
• POs for this year/Requisitions for next year
• Pitney Bowes
• Important Reminders for Year End
• Pcard

Floyd Patterson
Human Resource Service Center
• Grad Service Stipends
• Change/Terminate Grad Service Stipends
• Grad Non-Service Stipends

Budget Office
Steve MacPherson/Jenny Chinsen
• Reports/Inquiries/Queries
• Reminders – Budget Transfers
Procurement Services Website
bc.edu/procurement

Quick Guide to Making a Purchase

Welcome!

Use this page as a guide to help streamline the purchase process.

As a reminder, University policy requires that competitive bids be obtained and reviewed by Procurement Services from at least three (3) qualified vendors, when available, for all orders totaling $5,000 or more. When the bidding process does not apply, policy requires written justification and evidence from the department to Procurement prior to commitment of an order.
Purchase Check List

Purchase Process

As individuals with purchasing power on campus, it is our role to make fair, fiscally responsible, value-added purchases. Whether you are buying commodities, services or technology all purchases require the following steps:

1. Identify a purchase need  
2. Contact Procurement  
3. Create the requisition

To open the documents click on the images below.

Commodity Purchase Checklist  
Technology Purchase Checklist  
Professional Services Purchase Checklist  
Scientific Equipment Purchase Checklist

Each step includes a list of specific details to help you ensure that your purchase brings the best value to your department and the University. Review the applicable checklists below to guide you through the purchase process.

Following these steps allows for a timely and efficient experience.
Category and Supplier Information

The link below provides access to the Procurement Category and Vendor Information site. BC credentials are required; you will be asked to log in with your BC username and password.

Use this link to access the restricted procurement site.
# Category and Supplier Information

## Product/Services and Supplier Information: A - C

<table>
<thead>
<tr>
<th>Product or Service</th>
<th>Supplier</th>
<th>Contact Information</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advertising</td>
<td>Caliber Logo</td>
<td>Kevin Weber</td>
<td>View <a href="#">Caliber Logo’s website</a> for ideas only.</td>
</tr>
<tr>
<td></td>
<td>Diverse supplier</td>
<td><a href="mailto:Kevin@caliberlogo.com">Kevin@caliberlogo.com</a> 1-804-687-2134</td>
<td>Contact <a href="#">Kevin Weber</a> for pricing.</td>
</tr>
<tr>
<td>Advertising - Staff/Faculty Positions</td>
<td></td>
<td>Contact Human Resources at ext. 2-0383</td>
<td></td>
</tr>
<tr>
<td>Appliances</td>
<td>General Electric</td>
<td>Christina Divelbiss</td>
<td>View <a href="#">General Electric’s website</a> for ideas only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="mailto:Christina.Divelbiss@ge.com">Christina.Divelbiss@ge.com</a></td>
<td>Contact <a href="#">Christina Divelbiss</a> to purchase.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Reference MHEC Contract</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>BC Account number: D7F07</td>
</tr>
</tbody>
</table>
Year End Information Session

Updated Forms

Forms

PROCUREMENT SERVICES

Here, you will find forms that are available for downloading.

Procurement Related Forms:

- Sole Source Justification Form
- Purchase Order Change Request Form

Purchasing Card Related Forms:

- Purchasing Cardholder Agreement Form
- Purchasing Card Quiz

Accounts Payable Forms: In order to access these forms you will need to be logged into your BC Email Account

- Vendor Request Form
- Honorarium Request Form
- Voucher/Expense Delete Form
- Check Stop Payment
Change Order Request Form

Change Amount Information

Please indicate if the change order is an increase, decrease, close or cancel.

Change Order Type *

- Change order “Increase” [+]
- Change order “Decrease” [-]
- Close and disencumber funds
- Cancel

Never submit passwords through Google Forms.
Review Manage Requisitions to see if there is anything outstanding
Purchase Orders for this fiscal year

- PO Balance Report – to review remaining encumbrances

- Query – BC_PO_BY_DEPT to review Due Dates

- PO Activity Summary
BC Reports >> Purchasing >> PO Balances
Step by Step can be found at www.bc.edu/financialsystem
Year End Information Session

BC Reports >> Purchasing >> PO Balances
Step by Step can be found at www.bc.edu/financialsystem

Select PO Balance Report – BC_PO_R005
Year End Information Session

BC Reports >> Purchasing >> PO Balances
Step by Step can be found at [www.bc.edu/financialsystem](http://www.bc.edu/financialsystem)

<table>
<thead>
<tr>
<th>Req #</th>
<th>Req Ln #</th>
<th>PO #</th>
<th>PO Status</th>
<th>Lin #</th>
<th>Sch ed#</th>
<th>Dst#</th>
<th>BudDt</th>
<th>PO Dt</th>
<th>Orig. Amt</th>
<th>PO Amt</th>
<th>Vndr Name</th>
<th>Vchr #</th>
<th>Vchr Dt</th>
<th>Line Descr</th>
<th>Invoice #</th>
<th>Inv Dt</th>
<th>Pymnt Ref</th>
<th>Vchr Amt</th>
<th>Bal Amt</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td>0000096096</td>
<td>Dispatched</td>
<td>1</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td>2,000.00</td>
<td>1,220.00</td>
<td>ETON BIOSCIENCE INC</td>
<td></td>
<td></td>
<td>BLANKET PO FOR</td>
<td></td>
<td></td>
<td></td>
<td>1,220.00</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td></td>
<td>0000097228</td>
<td>Dispatched</td>
<td>1</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td>650.34</td>
<td>639.09</td>
<td>INTEGRATED DNA TECHN</td>
<td></td>
<td></td>
<td>blanket po for</td>
<td></td>
<td></td>
<td></td>
<td>639.09</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td></td>
<td>0000099093</td>
<td>Dispatched</td>
<td>1</td>
<td>1</td>
<td>Split</td>
<td></td>
<td></td>
<td>1,000.00</td>
<td>2,622.22</td>
<td>EUROFINS MWF OPERAN</td>
<td>00842899</td>
<td>9/14/2016</td>
<td>blanket po for</td>
<td>SINO0037 3275</td>
<td></td>
<td>44.88</td>
<td>2,410.95</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td></td>
<td>0000099093</td>
<td>Dispatched</td>
<td>1</td>
<td>1</td>
<td>Split</td>
<td></td>
<td></td>
<td>1,000.00</td>
<td>2,622.22</td>
<td>EUROFINS MWF OPERAN</td>
<td>00842900</td>
<td>9/14/2016</td>
<td>blanket po for</td>
<td>SINO0038 4021</td>
<td></td>
<td>51.51</td>
<td>2,410.95</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td></td>
<td>0000099093</td>
<td>Dispatched</td>
<td>1</td>
<td>1</td>
<td>Split</td>
<td></td>
<td></td>
<td>1,000.00</td>
<td>2,622.22</td>
<td>EUROFINS MWF OPERAN</td>
<td>00842901</td>
<td>9/14/2016</td>
<td>blanket po for</td>
<td>SINO0045 6222</td>
<td></td>
<td>13.80</td>
<td>2,410.95</td>
<td></td>
</tr>
</tbody>
</table>
### BC_PO_BY_DEPT - Purchase Orders by Dept

<table>
<thead>
<tr>
<th>PO No.</th>
<th>Name</th>
<th>PO Date</th>
<th>Due Date</th>
<th>Status</th>
<th>Budget Status</th>
<th>Buyer</th>
<th>Status</th>
<th>Req Line</th>
<th>Line Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000104931</td>
<td>M&amp;H MAINTENANCE INC</td>
<td>06/01/2016</td>
<td>05/31/2017</td>
<td>Dispatched</td>
<td>Valid</td>
<td>KEENANBF</td>
<td>Active</td>
<td>1</td>
<td>AGMT M&amp;H St. John's Refectory Floor Cleaning Summer &amp; Academic</td>
</tr>
<tr>
<td>0000105979</td>
<td>M&amp;H MAINTENANCE INC</td>
<td>07/05/2016</td>
<td>05/31/2017</td>
<td>Dispatched</td>
<td>Valid</td>
<td>KEENANBF</td>
<td>Active</td>
<td>1</td>
<td>AGMT M&amp;H 129 Lake Cafe Floor Cleaning Summer &amp; Academic</td>
</tr>
<tr>
<td>0000105979</td>
<td>M&amp;H MAINTENANCE INC</td>
<td>07/05/2016</td>
<td>05/31/2017</td>
<td>Dispatched</td>
<td>Valid</td>
<td>KEENANBF</td>
<td>Active</td>
<td>2</td>
<td>Additional Cleaning for Facilities at 129 Lake St.</td>
</tr>
<tr>
<td>0000106063</td>
<td>CAMELOT ENTERPRISES</td>
<td>07/07/2016</td>
<td>05/31/2017</td>
<td>Dispatched</td>
<td>Valid</td>
<td>MCCLAYCE</td>
<td>Active</td>
<td>1</td>
<td>Blanket PO - 129 Lake Uniforms</td>
</tr>
</tbody>
</table>
Purchase Order Activity Summary

Navigation: Purchasing > Purchase Orders > Review PO Info > Activity Summary

Type in the Purchase Order and/or Vendor ID and click Search

PO Activity Summary

Enter any information you have and click Search. Leave fields blank for a list of all values.

Find an Existing Value

Search Criteria

Business Unit: 
PO Number: begins with 0000080046
Purchase Order Date: 
Purchase Order Reference: begins with
Vendor ID: begins with

Case Sensitive

Search Clear Basic Search Save Search Criteria
Click on **Invoice** tab to view the available PO balance.

**Activity Summary**

<table>
<thead>
<tr>
<th>Business Unit:</th>
<th>EAGLE</th>
<th>PO Status:</th>
<th>Dispatched</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchase Order:</td>
<td>00000000045</td>
<td>Vendor:</td>
<td>F W WEBB COMPANY</td>
</tr>
<tr>
<td>Merchandise Amount:</td>
<td>56,000.00 USD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Merchandise Receipt:</td>
<td>0.00 USD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Merchandise Returned:</td>
<td>0.00 USD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Merchandise Invoice:</td>
<td>55,815.71 USD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Merchandise Matched:</td>
<td>55,815.71 USD</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Line</th>
<th>Item</th>
<th>Item Description</th>
<th>UOM</th>
<th>Order Qty</th>
<th>Amount Ordered</th>
<th>Currency</th>
<th>Amount Only</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>BLANKET-FAC-HVAC PARTS ACADEMI</td>
<td>EA</td>
<td>1.0000</td>
<td>56,000.00 USD</td>
<td>USD</td>
<td></td>
</tr>
</tbody>
</table>

Click on the icon ![icon](bottom for Voucher information.

**Activity Summary**

<table>
<thead>
<tr>
<th>Business Unit:</th>
<th>EAGLE</th>
<th>PO Status:</th>
<th>Dispatched</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchase Order:</td>
<td>00000000045</td>
<td>Vendor:</td>
<td>F W WEBB COMPANY</td>
</tr>
<tr>
<td>Merchandise Amount:</td>
<td>56,000.00 USD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Merchandise Receipt:</td>
<td>0.00 USD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Merchandise Returned:</td>
<td>0.00 USD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Merchandise Invoice:</td>
<td>55,815.71 USD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Merchandise Matched:</td>
<td>55,815.71 USD</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Line</th>
<th>Item</th>
<th>Item Description</th>
<th>UOM</th>
<th>Amount Only</th>
<th>Un-invoiced Amount</th>
<th>Currency</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>BLANKET-FAC-HVAC PARTS ACADEMI</td>
<td>EA</td>
<td>55,815.71 USD</td>
<td>184,290 USD</td>
<td>USD</td>
</tr>
</tbody>
</table>

**NOTE:** If there is more than one line on the P.O., click on each individual line item.
View Voucher numbers. If you need a copy of an invoice, look up the voucher through Regular Entry and click on the Nolij Docs link under the Invoice Information tab.
**Year End Information Session**

**Requisitions for next fiscal year**
- **Due Date** – 5/31/18
- **Agreements** – can not cross fiscal years

<table>
<thead>
<tr>
<th>Vendor</th>
<th><strong>Click</strong> and enter the vendor name, click <strong>Find</strong> and select the vendor by clicking on the <strong>Vendor ID</strong> hyperlink</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td><strong>Click</strong> and enter category name or click <strong>Find</strong> for a listing of all categories</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td><strong>Click</strong> and select from the list</td>
</tr>
<tr>
<td>Due Date</td>
<td>5/31/xx for a yearly agreement or blanket. You will receive a message – “Warning – date out of range” – if you are using a date more than 30 days in the future. Click <strong>OK</strong></td>
</tr>
<tr>
<td>Chartstring</td>
<td>Enter the chartstring that will be used on all lines of the order. <strong>Do not</strong> complete Account number as this will populate based on the Category selected.</td>
</tr>
</tbody>
</table>
Entering the correct Budget Date to charge next fiscal year
Click Details tab – enter the budget date for next fiscal year – 6/3/2017
Processing in the correct fiscal year

- **Prepaid Expense**
  - Expenses paid in FY17 relating to FY18 event or service
  - Amount over $4,000
  - Paid from a prepaid expense account 15440
  - Scan or send original invoice to AP, copy of invoice to Greg Moore, 129 Lake, Rm 428

- **Accrued Expense**
  - Expenses for FY17 event or service paid in FY18
  - Amount over $4,000
  - Paid from an accrual account 20020
  - Scan or send original invoice to AP, copy of invoice to Greg Moore, 129 Lake, Rm 428
  - Copy should include voucher number and chartstring
  - You must have budget funds available
  - Accepted payments made to account 20020 **until June 16th**
Pitney Bowes Barcode Create in New Budget Year

• Change fiscal year value to 2018

• All chart of account fields are required

• Projects/Grant – enter appropriate project/grant ID

• Fiscal year does not apply to projects/grants

• Must have existing budget in new fiscal year to create barcode

• Copies of barcode accepted
Queries

Reporting Tools >> Query >> Query Viewer

- BC_AP_VCHR_NOT_SUBMITTED
  » Voucher was not submitted

- BC_AP_VCHR_AP_APPR
  » AP did not receive the paperwork

- BC_AP_VR_SCAN_INFO_FOR_DEPTS
  » List of vouchers and scanned images
Year End Information Session

Office of the Controller
Year End Website

Welcome to the Year End Expenditure Guideline Web page. In compliance with standard audit procedures for Colleges and Universities, departmental guidelines for delivery of goods and services by May 31st have been established for the remainder of this fiscal year. Please review the detailed guidelines with those individuals in your department who have budget and purchasing responsibilities within PeopleSoft.

The University’s goal with these preliminary guidelines is to alert departments to fiscal year end dates and provide sufficient planning time to purchase goods and services for the current year using their FY17 budget funds. If you have any questions about the information on the Year End Expenditure Guideline Web pages, please contact Greg Moore at 2-3362.

Please see the FY17 Year End Information Presentation and contact Rita Carlo at 2-4855 with any questions.

Important Deadlines for FY17

| March 27 | • Last day to order Furniture for delivery by May 31st |
| April 7  | • Last day for FY17 requisitions for major equipment to be bid out |
| April 14 | • Original FY18 Operating Budget Load |
Important Dates

www.bc.edu/offices/controller

- Apple orders – April 28th
- Monthly Supplemental Budget Transfers – May 3rd
- Dell – May 5th
- Ricoh – May 12th
- Temporary Payroll Budget Transfers – May 12th
- Weekly Supplemental Budget Transfers – May 19th
- Pcard budget transfer – May 25th – by 3:00pm
- Dept/Fund/Special Acct Approvals – Wednesday, May 31st – 12:00pm
  (documentation hand delivered or scanned)
- Shut Down - Wednesday, May 31st – 12:00pm
- Hand deliver/Scan paperwork – Wednesday, May 31st – 3:00pm
- Delivery of goods – by Wednesday, May 31st
## Year End Information Session

<table>
<thead>
<tr>
<th>Helpful Websites</th>
<th>URL/Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller’s Year End</td>
<td><a href="http://www.bc.edu/yearend">www.bc.edu/yearend</a></td>
</tr>
<tr>
<td>PeopleSoft Financials</td>
<td><a href="http://www.bc.edu/financialsystem">www.bc.edu/financialsystem</a></td>
</tr>
<tr>
<td>Procurement Services</td>
<td><a href="http://www.bc.edu/procurement">www.bc.edu/procurement</a></td>
</tr>
<tr>
<td>Vendors/Suppliers</td>
<td><a href="http://www.bc.edu/supplier">www.bc.edu/supplier</a></td>
</tr>
<tr>
<td>University Travel Program</td>
<td><a href="http://www.bc.edu/travel">www.bc.edu/travel</a></td>
</tr>
<tr>
<td>Pcard Information</td>
<td><a href="http://www.bc.edu/pcard">www.bc.edu/pcard</a></td>
</tr>
<tr>
<td>US Bank Access</td>
<td><a href="https://access.usbank.com">https://access.usbank.com</a></td>
</tr>
<tr>
<td>Human Resources</td>
<td><a href="http://www.bc.edu/hr">www.bc.edu/hr</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Emails</th>
<th>Email Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts Payable</td>
<td><a href="mailto:acctpay@bc.edu">acctpay@bc.edu</a></td>
</tr>
<tr>
<td>Pcard Questions</td>
<td><a href="mailto:pcard@bc.edu">pcard@bc.edu</a></td>
</tr>
<tr>
<td>Procurement Services</td>
<td><a href="mailto:purchase@bc.edu">purchase@bc.edu</a></td>
</tr>
</tbody>
</table>
Year End Information Session

*P-card*
P-card

Requirements for April and May:

• Be proactive by reviewing your p-card balances.
  – Query for p-card budget low: Reporting tools>query>query viewer.

• Use the cardholder email listing if necessary, to contact all cardholders in the department to inform them of p-card balances or important dates and reminders.

• Review pending orders with vendors to be sure you are billed for, or cancel, any backordered items or they will be on FY18 budget.
End of May

- Budget transfers into P-card account must be done by May 25, 2016 by 3:00 p.m. to be available by May 29, 2017.
  
  *Transfers usually hit in one day but may take up to two days to be available to spend.*

- Vendors must bill your P-card and send transactions to the bank by 5:00 p.m. on May 31 to hit your FY17 budget.
  
  *Remember to place orders with enough time for delivery by May 31.*

- Please do not remove money from your P-card line. You may have pending transactions by other cardholders.
Preparing for P-card FY18

- **PERMANENT** transfers into the P-card account will ensure the P-cards open automatically with funding available on **June 2, 2016 @ 12:00pm**

- Review the list of P-card holders in BC Custom Menu to **inactivate** any cardholders who should no longer have access and to review access levels for current cardholders.

- Inactivate any cards on **expired grants or programs**.
Utilizing US Bank’s Access-on-line

• US Bank’s Access-On-Line program now provides departmental p-card administrators access to more information such as up-to-the-minute account balances and real-time transaction information.

• This access also allows department p-card administrators to check the reasons for the department’s declined transactions.

• If your department would like this new access, please send the name of the designated department p-card administrators and Dept. ID in an e-mail to pcard@bc.edu
Vendor Information
**Status of Vendors - Query**

![Query Image]

**Download results in:** Excel Spreadsheet, CSV Text File, XML File (13 kb)

<table>
<thead>
<tr>
<th>Vendor ID</th>
<th>Name1</th>
<th>Name2</th>
<th>Vendor Status</th>
<th>1099 Withholding</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000001832</td>
<td>SECURITY ENGINEERED MACHINERY CO INC</td>
<td></td>
<td>Inactive</td>
<td>N</td>
</tr>
<tr>
<td>0000004919</td>
<td>SECURITY LOCK CO</td>
<td></td>
<td>Inactive</td>
<td>N</td>
</tr>
<tr>
<td>0000005152</td>
<td>SECURITY SYSTEMS INC</td>
<td></td>
<td>Inactive</td>
<td>N</td>
</tr>
<tr>
<td>0000006044</td>
<td>SECOND LIFE BOOKS INC</td>
<td></td>
<td>Inactive</td>
<td>N</td>
</tr>
<tr>
<td>0000010526</td>
<td>SECOND HELPING GALA</td>
<td></td>
<td>Inactive</td>
<td>N</td>
</tr>
</tbody>
</table>
Doing Business With BC
Procurement Services’ website>>Doing Business with BC>>W9

Doing Business With BC

PROCUREMENT SERVICES

Welcome to Boston College. This section of our web site is dedicated to information that may be of relevance to companies who are doing business, or wish to do business, with Boston College. Boston College is a diverse community and requires a great deal of resources to keep it running well. Your help in providing these resources is greatly appreciated.

We hope you find this information helpful. If you require additional information, please contact the Procurement Services Office at 617-552-3055 or by e-mail at Purchasing@bc.edu. Please be aware of the University’s holiday schedule for days the University will be closed.

In order to pre-qualify to provide goods or services to Boston College, please contact the appropriate buyer in the Boston College Procurement Services Department. Please see the Categories section of this Web site to determine the buyer responsible for procuring your product.

Notice to Suppliers: Fraudulent Purchase Order Email Activity

We want to alert you to an active email scam involving purchase orders and request for product quotations that purport to originate from Boston College, but are, in fact, fraudulent. While the university cannot prevent this illegal activity, we have alerted the appropriate authorities.
Foreign Vendor Request Form

- [www.bc.edu/supplier](http://www.bc.edu/supplier)
- All foreign vendors should complete this form
- Vendor query contains important foreign vendor information
- Glacier (Arctic Intl) tax treaty software
- Be proactive with foreign vendors
Vendor Request Form
Use to request a change to an existing vendor or add an Individual for reimbursement.
Vendor questions
Laura Denzer
acctpay@bc.edu

Foreign Vendor questions
Rita Carlo
2-4855
Don’t Forget - Voucher Submit button
Don’t Forget – Approve Transactions

Transactions to Approve

<table>
<thead>
<tr>
<th>Select</th>
<th>Transaction Type</th>
<th>Total</th>
<th>Unit</th>
<th>Name</th>
<th>Employee ID</th>
<th>Date Submitted</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>0.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Comments

Return to Approval List
Employee Expense History
Return to Travel and Expenses

Overview | Expense Reports | Travel Authorizations | Cash Advances | Errors
Expense Submit, Budget Check, Approve
Step by Step can be found at www.bc.edu/financialsystem

- If a **P2B or P3** enters an Expense Report under Employee Self Service, the transaction will be routed to the designated P2A to verify the Chartstring, Budget Check and Approve the expense report. For a list of the designated P1s and P2s for a department, we have developed a query, BC_WF_P1_P2_APPROVER_LIST.

- If a **P2A** in the department enters an Expense Report, it is now a three-step process to (1) Submit under Employee Self Service and (2) Budget Check and (3) Approve the Expense Report under Travel & Expenses. After submitting the Expense Report, the P2A **must navigate** to an approval page under Travel and Expenses to Budget Check and Approve.
Human Resource Service Center
HR Forms

- Grad Service Stipends
- Change Service Stipends
- Terminating Grad Students
- Grad Non-Service Stipends
Helpful Hints

- Always use the first and last day of the month for Grad Stipends
- Process stipends before the first day of a month in order to be paid for the 16th of that month
- Always check your “Approval Status” to make sure it has been processed by HRSC
- Grad Stipends need approval and if applicable funding and tax specialist approval before it can be paid
HR – GRADUATE SERVICE STIPENDS

BC CUSTOM > USE > Graduate Service Stipends

A student needs to work in order to receive this stipend. Click Add a New Value.

Click Add.
Remember to change the School Year to 2017. Multiple hires can be processed for an individual, but it is not recommended because the PS HR system cannot handle more than one change on the same day. Manual hires have to be done by HRSC. Complete form and click.
HR - CHANGE/TERMINATE SERVICE STIPEND

STUDENT/GRAD/PTFCHANGES>USE>STU/GRAD/PTFECR CREATE

Create pay rate changes, job earnings distributions and terminations all within this screen.

Enter the Name or Eagle ID of the employee as well as any available field to narrow search.

![Screenshot of the Stu / Grad / PTF ECR Create interface](image_url)
Year End Information Session

Change Criteria Search Page

From here you will be able to process an ECR action:
- Earnings Distribution and Extension
- Pay Rate Change
- Termination
WHERE TO FIND DETAILED INSTRUCTIONS

http://www.bc.edu/offices/hr/managers.html
HR – GRAD NON-SERVICE STIPEND

BC CUSTOM > USE > Grad Non-Service Stipend

Do not have to work to receive this stipend. Payment is received through Accounts Payable. Remember to change the **Current Year** to 2017.

Due to semester swap, do not use the months of December and May! Enter September through November or January through April.

The preference is one check issued at the beginning of each semester for the semester.

Click **Save**
Steve MacPherson

Budget Office
Year End Information Session

Reports

- ACR
  - Setting up a new Run Control ID
- Grants

Inquiries

- Budget Overview Inquiry
- Transactional Detail Inquiry

Queries

- BC_KK_ACR_LIM_SLRY (or BC_KK_ACR_RANGE_LIM_SLRY)
- BC_KK_ACTUALS_TRNS_DTL_LIM_SLRY
- BC_GM_BUD_ACCTD_GRANTS
ACR Report

Provides budgeted and expended summary data with balance available.

Navigation: BC Report > Commitment Control > ACR Report

Step 1: First time in set up a new Run Control by clicking Add a New Value
Step 2: Enter a Run Control ID name that contains no dashes or spaces (underscores are fine).

ACR-NEW

Enter any information you have and click Search. Leave fields blank for a list of all values.

Search by: Run Control ID begins with Demo

[Search] Advanced Search
Year End Information Session

**Step 3: Enter Budget Period, Accounting Period and Department.**

**Business Unit:** EAGLE (will default)  
**Department:** xxxxxx

**Budget Period:** Enter Budget Year i.e. 2017  
**Account Period** – Enter Period i.e. 4 (September)

**Fund Code Range** – Select ALL or appropriate Fund code (2xx, 6xx or 9xx)

**Salary Data** will default based on your role.

**Step 4: Click** Run

---

[Image of the user interface with select options for Business Unit, Budget Period, Account Period, Fund Code Range, and Salary Data.]

---

[Image of the user interface with fields for Department, Fund Code, Fund Source, Program Code, Function, and Property.]
Step 5: Select Report format

Process Scheduler Request

User ID: MACPHEST
Run Control ID: ACR

Server Name: PSUNIX
Recurrence: 
Time Zone: 
Run Date: 04/11/2016
Run Time: 2:05:53PM

Process List

<table>
<thead>
<tr>
<th>Process Name</th>
<th>Process Type</th>
<th>*Type</th>
<th>*Format</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>BCGLR004</td>
<td>SQR Process</td>
<td>Web</td>
<td>PDF</td>
<td>Distribution</td>
</tr>
<tr>
<td>BCGLR005</td>
<td>SQR Process</td>
<td>Web</td>
<td>PDF</td>
<td>Distribution</td>
</tr>
<tr>
<td>BCGLR013</td>
<td>SQR Report</td>
<td>Web</td>
<td>PDF</td>
<td>Distribution</td>
</tr>
</tbody>
</table>

OK  Cancel
This will open up the ACR Report. Note: Once you open the PDF, you can save it by selecting File > Save As > …

<table>
<thead>
<tr>
<th>Expenses</th>
<th>Original Budget</th>
<th>Revised Budget</th>
<th>YTD Actuals</th>
<th>Encumbrances</th>
<th>Budget Bal Avail</th>
<th>% Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplies General</td>
<td>68730</td>
<td>0</td>
<td>0</td>
<td>$12</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Mailing Postage Freight</td>
<td>68010</td>
<td>0</td>
<td>0</td>
<td>2,417</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Aux Internal Parking Chst</td>
<td>67710</td>
<td>0</td>
<td>0</td>
<td>50</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Cat Meetings Meals Intern</td>
<td>67800</td>
<td>0</td>
<td>0</td>
<td>3,091</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Univ Credit Card Disc Fee</td>
<td>63030</td>
<td>0</td>
<td>0</td>
<td>1,105</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>General¹</td>
<td>64001</td>
<td>10,210</td>
<td>8,140</td>
<td>7,285</td>
<td>0</td>
<td>090</td>
</tr>
<tr>
<td>Professional Independent</td>
<td>63390</td>
<td>0</td>
<td>0</td>
<td>12,100</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>External Services¹</td>
<td>64002</td>
<td>7,429</td>
<td>12,213</td>
<td>12,100</td>
<td>0</td>
<td>113</td>
</tr>
<tr>
<td>Print Minor Printings &lt;$5</td>
<td>68306</td>
<td>0</td>
<td>0</td>
<td>4,181</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Print Design</td>
<td>68303</td>
<td>0</td>
<td>0</td>
<td>975</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Printing¹</td>
<td>68000</td>
<td>5,502</td>
<td>5,157</td>
<td>5,156</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>PCard</td>
<td>68370</td>
<td>0</td>
<td>500</td>
<td>160</td>
<td>0</td>
<td>337</td>
</tr>
<tr>
<td>Travel¹</td>
<td>68300</td>
<td>690</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Total:</strong></td>
<td><strong>28,838</strong></td>
<td><strong>26,018</strong></td>
<td><strong>24,675</strong></td>
<td><strong>0</strong></td>
<td><strong>1,343</strong></td>
<td><strong>5.2</strong></td>
</tr>
</tbody>
</table>
Grant Reports

For instructions on how to run the below reports, please go to OSP’s website: http://www.bc.edu/research/osp/assistdoc.html.


- **Grant Online ACR** - Provides budgeted and expended summary data with balance available.

- **Grant Online TDR** - Provides detail activity. It contains individual transactional detail for the budget transfers, requisitions, purchase orders, vouchers, expense reports, salary encumbrances, salary actuals, and journal entries for standard charges (PCard, Pitney Bowes, BOC) and allocations (Fringe Benefits, Plant Maintenance, F&A)
Budget Overview

The purpose of this inquiry is to provide information about each transaction that makes up a total amount budgeted, pre-encumbered, encumbered and expensed to an account.

Step by Step Guide: https://www.bc.edu/content/bc/bcres/bcresfinancials/reports.html

**Navigation:** Commitment Control > Review Budget Activities > Budgets Overview

**Step 1:** First time in set up a new Search Criteria by clicking Add a New Value

**Step 2:** Enter an Inquiry Name that contains no dashes or spaces (underscores are fine).

Inquiry Name:

**Step 3:** Click Add
Year End Information Session

BUDGET OVERVIEW TRANSACTION INQUIRY / REPORT INPUT KEY

**Search**
Click to run inquiry

**Calendar Type:**
Select "Detail Budget Period"

**Period:**
Enter Budget Period

**Charfield Criteria**
Enter criteria, at least one CANNOT be a wildcard. A range or % (wildcard) can also be used

**Description**
Enter a description for your entry (optional)

**Ledger Group**
Select ledger group: EXPBUDGETS or REVBUDGETS

The image shows a screenshot of a budget overview transaction inquiry report input key, highlighting the fields and options for a user to search and filter budget information.
Year End Information Session

**BUDGET OVERVIEW TRANSACTION INQUIRY / REPORT MAP**

**Overall Totals:**
- Budget: 434,094.00
- Expense: 407,033.44
- Encumbrance: 0.00

**Column Order:**
Column order can be rearranged by dragging column header to new location.

**Max Rows**
- Defaults to 250.
- Optional: Increase and push Search to refresh with more rows.

**Print BOTR**
- Produces a PDF transaction report for all chartstrings searched for in the Budget Overview criteria.

**Print Exp Pcard Rpt**
- Produces a transaction report that groups Pcard spend type.

**Zoomed in Budget Overview Results:**

<table>
<thead>
<tr>
<th>Budget Overview Results</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ledger Group</strong></td>
<td><strong>Dept</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>--</td>
</tr>
<tr>
<td>1</td>
<td>EBPBUDGETS</td>
</tr>
<tr>
<td>2</td>
<td>EBPBUDGETS</td>
</tr>
<tr>
<td>3</td>
<td>EBPBUDGETS</td>
</tr>
</tbody>
</table>

**Drill to Transactions (and to vouchers or journals)**
- Shows Budget Transaction Types
- Shows Budget Details

**Zoom:**
- Expands Budget Overview Results (example below)
- Download to Excel
Transaction Detail Inquiry

Navigation: **BC Report > Commitment Control > TDI LMTD ACCTS**

*Step 1: Enter appropriate values*

**TDI LMTD ACCTS**

Enter any information you have and click Search. Leave fields blank for a list of all values.

- **Find an Existing Value**
- **Search Criteria**
  - Business Unit: begins with **EAGLE**
  - Department: =
  - Fund Code: begins with
  - Fund Source: begins with
  - Program Code: begins with
  - Function: begins with
  - Property: begins with
  - Account: begins with
  - Budget Period: begins with

[Buttons: Search, Clear, Basic Search, Save Search Criteria]
**Navigation:** Reporting Tools > Query > Query Viewer > BC_KK_ACR_RANGE_LIM_SLRY

You must enter values in the following fields: Budget Period, Account (begin range) and Account (end range). You can use the %, which is a wildcard that will bring back results for all Departments and Funds.

### Account Ranges:
- Revenue account range: 40000 : 49999
- Expense Account Range: 50000: 76999
  - Salaries: 5%
  - Expenses: 6%
  - Allocations & Transfers: 7%

---

<table>
<thead>
<tr>
<th>Budget Period</th>
<th>VP Code</th>
<th>Dept</th>
<th>Descr</th>
<th>Fund</th>
<th>Fund Source</th>
<th>Program</th>
<th>Descr</th>
<th>Property</th>
<th>Function</th>
<th>Budget Account</th>
<th>Account Descr</th>
<th>Original Budget</th>
<th>Perm Xfers &amp; Adjs</th>
<th>Plan Base</th>
<th>Temp Xfers &amp; Adjs</th>
<th>Revised Budget</th>
</tr>
</thead>
<tbody>
<tr>
<td>2013</td>
<td>SVP</td>
<td>025321</td>
<td>Grad Housing</td>
<td>355</td>
<td>10000</td>
<td>00000</td>
<td>No Program</td>
<td>00000</td>
<td>501</td>
<td>63090</td>
<td>Facility Property Leases</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>368251</td>
<td>368251</td>
</tr>
</tbody>
</table>
**Navigation:** Reporting Tools > Query > Query Viewer > BC_KK_ACR_LIM_SLRY

You must enter values in the following fields: Department, Fund Code, Fund Source, Program Code, Property and Budget Period. You can use the %, which is a wildcard that will bring back results for all Functions and Accounts.

### BC_KK_ACR_LIM_SLRY - Bud & Acctd Data with SLRY

<table>
<thead>
<tr>
<th>Department</th>
<th>Fund Code</th>
<th>Fund Source</th>
<th>Program Code</th>
<th>Function</th>
<th>Property</th>
<th>Account</th>
<th>Budget Period</th>
<th>Description</th>
<th>Original Budget</th>
<th>Temp Xfers &amp; Adj</th>
<th>Perm Xfers &amp; Adj</th>
<th>Revised Budget</th>
<th>Actuals</th>
<th>Total Pre Encumbered</th>
<th>Total Encumbered</th>
<th>Budget Bal Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>025321</td>
<td>355</td>
<td>10000</td>
<td>00000</td>
<td>%</td>
<td>00000</td>
<td>6%</td>
<td>2013</td>
<td>Facility Property Leases</td>
<td>0</td>
<td>368251</td>
<td>0</td>
<td>368251</td>
<td>341990.72</td>
<td>0.000</td>
<td>0.000</td>
<td>27000</td>
</tr>
<tr>
<td>025321</td>
<td>355</td>
<td>10000</td>
<td>00000</td>
<td>%</td>
<td>00000</td>
<td>6%</td>
<td>2013</td>
<td>Facility Lease Utilities</td>
<td>0</td>
<td>16418</td>
<td>0</td>
<td>16418</td>
<td>16417.72</td>
<td>0.000</td>
<td>0.000</td>
<td>0</td>
</tr>
<tr>
<td>025321</td>
<td>355</td>
<td>10000</td>
<td>00000</td>
<td>%</td>
<td>00000</td>
<td>6%</td>
<td>2013</td>
<td>General^</td>
<td>0</td>
<td>49425</td>
<td>0</td>
<td>49425</td>
<td>49425.00</td>
<td>0.000</td>
<td>0.000</td>
<td>0</td>
</tr>
<tr>
<td>025321</td>
<td>355</td>
<td>10000</td>
<td>00000</td>
<td>%</td>
<td>00000</td>
<td>6%</td>
<td>2013</td>
<td>Contract Services</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>49425.00</td>
<td>0.000</td>
<td>0.000</td>
<td>0</td>
</tr>
</tbody>
</table>

Download results in: [Excel Spreadsheet](#) [CSV Text File](#) [XML File](#) (2 kb)
**Navigation:** Reporting Tools > Query > Query Viewer > BC_KK_ACR_STDNT_SLRY

You must enter values in the following fields: Department, Fund Code, Fund Source, Program Code, Property and Budget Period. You can use the %, which is a wildcard that will bring back results for all Functions and Accounts.

<table>
<thead>
<tr>
<th>Department</th>
<th>Fund Code</th>
<th>Fund Source</th>
<th>Program Code</th>
<th>Function</th>
<th>Account</th>
<th>Budget Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>025321</td>
<td>355</td>
<td>10000</td>
<td>00000</td>
<td>%</td>
<td>6%</td>
<td>2013</td>
</tr>
</tbody>
</table>

**Download results in:** Excel Spreadsheet, CSV Text File, XML File (2 kb)

<table>
<thead>
<tr>
<th>Descr</th>
<th>Account</th>
<th>Actual Account</th>
<th>Account Descr</th>
<th>Function</th>
<th>Original Budget</th>
<th>Temp Xfers &amp; Adj</th>
<th>Perm Xfers &amp; Adj</th>
<th>Revised Budget</th>
<th>Actuals</th>
<th>Total Pre Encumbered</th>
<th>Total Encumbered</th>
<th>Budget Bal Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grad Housing</td>
<td>63090</td>
<td>63090</td>
<td>Facility Property Leases</td>
<td>501</td>
<td>368251</td>
<td>0</td>
<td>0</td>
<td>368251</td>
<td>341190.72</td>
<td>0.000</td>
<td>0.000</td>
<td>27060</td>
</tr>
<tr>
<td>Grad Housing</td>
<td>63095</td>
<td>63095</td>
<td>Facility Lease Utilities</td>
<td>501</td>
<td>16418</td>
<td>0</td>
<td>0</td>
<td>16418</td>
<td>16417.72</td>
<td>0.000</td>
<td>0.000</td>
<td>0</td>
</tr>
<tr>
<td>Grad Housing</td>
<td>64001</td>
<td>64001</td>
<td>Generalh</td>
<td>501</td>
<td>49425</td>
<td>0</td>
<td>0</td>
<td>49425</td>
<td>49425.00</td>
<td>0.000</td>
<td>0.000</td>
<td>0</td>
</tr>
</tbody>
</table>
### Year End Information Session

**Navigation:** Reporting Tools > Query > Query Viewer > BC_KK_ACTUALS_TRNS_DTL_LIM_SAL

You must enter a value in Budget Period. You can use the %, which is a wildcard that will bring back results for any other fields.

#### BC_KK_ACTUALS_TRNS_DTL_LIM_SAL - Actuals Trans Dtl with Salary

<table>
<thead>
<tr>
<th>Tran ID</th>
<th>Tran Date</th>
<th>Accounting Period</th>
<th>Dept</th>
<th>Descr</th>
<th>Fund</th>
<th>Fund Source</th>
<th>Program</th>
<th>Function</th>
<th>Property</th>
<th>Parent Node</th>
<th>Account</th>
<th>Descr</th>
<th>Sum Amount</th>
<th>Document</th>
<th>Descr Ln1</th>
<th>Descr Ln2</th>
<th>Descr Ln3</th>
<th>Descr Ln4</th>
<th>Descr Ln5</th>
<th>Descr Ln6</th>
<th>Descrip</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0001345448</td>
<td>07/15/2012</td>
<td>205321</td>
<td>Grad Housing</td>
<td>365</td>
<td>10000</td>
<td>00000</td>
<td>501</td>
<td>00000</td>
<td>63090</td>
<td>63090</td>
<td>Facility Property Leases</td>
<td>35467.320</td>
<td>C00424535</td>
<td>CashNet Department Deposit</td>
<td>6/29 GRD</td>
<td>HSG COM</td>
<td>0743160713</td>
<td>CashNet Deposit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0001345448</td>
<td>07/15/2012</td>
<td>205321</td>
<td>Grad Housing</td>
<td>365</td>
<td>10000</td>
<td>00000</td>
<td>501</td>
<td>00000</td>
<td>63090</td>
<td>63090</td>
<td>Facility Property Leases</td>
<td>12665.280</td>
<td>C00424535</td>
<td>CashNet Department Deposit</td>
<td>6/29 GRD</td>
<td>HSG EMB</td>
<td>0743160713</td>
<td>CashNet Deposit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0001345448</td>
<td>07/16/2012</td>
<td>205321</td>
<td>Grad Housing</td>
<td>365</td>
<td>10000</td>
<td>00000</td>
<td>501</td>
<td>00000</td>
<td>63090</td>
<td>63090</td>
<td>Facility Property Leases</td>
<td>18765.840</td>
<td>C00424535</td>
<td>CashNet Department Deposit</td>
<td>6/29 GRD</td>
<td>HSG STR</td>
<td>0743160713</td>
<td>CashNet Deposit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0001348491</td>
<td>07/25/2012</td>
<td>205321</td>
<td>Grad Housing</td>
<td>365</td>
<td>10000</td>
<td>00000</td>
<td>501</td>
<td>00000</td>
<td>63090</td>
<td>63090</td>
<td>Facility Property Leases</td>
<td>95548.340</td>
<td>000425812</td>
<td>Reverse FY12 grad housing prep</td>
<td>grad housing comm ave</td>
<td>Reverse FY12 grad housing prepaid</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
You must enter values in the following fields: Department, Fund Code, Fund Source, Program Code, Function, Property, Account and Project/Grant. You can use the %, which is a wildcard for all fields and just enter the Project ID.

### Download results in:
- Excel Spreadsheet
- CSV Text File (6 kb)

<table>
<thead>
<tr>
<th>Unit</th>
<th>Project/Grant</th>
<th>Parent Node</th>
<th>Account</th>
<th>Descr</th>
<th>Function</th>
<th>Original Budget</th>
<th>TEMP_REV</th>
<th>PERM</th>
<th>Revised Budget</th>
<th>Actual</th>
<th>Pre Encumbered</th>
<th>Encumbered</th>
<th>Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EAGLE</td>
<td>50010</td>
<td>50010</td>
<td>Salary Faculty FT OSPA</td>
<td>301</td>
<td>0.00</td>
<td>0.00</td>
<td>38814.00</td>
<td>38814.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>38814.00</td>
</tr>
<tr>
<td>2</td>
<td>EAGLE</td>
<td>51300</td>
<td>51300</td>
<td>Salary Rsh Assoc FT Exempt</td>
<td>301</td>
<td>0.00</td>
<td>0.00</td>
<td>10000.00</td>
<td>10000.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>10000.00</td>
</tr>
<tr>
<td>3</td>
<td>EAGLE</td>
<td>53330</td>
<td>53330</td>
<td>Salary Grad Research Assist</td>
<td>301</td>
<td>0.00</td>
<td>0.00</td>
<td>180000.00</td>
<td>180000.00</td>
<td>2833.34</td>
<td>0.00</td>
<td>15217.00</td>
<td>16214.66</td>
</tr>
<tr>
<td>4</td>
<td>EAGLE</td>
<td>68370</td>
<td>68370</td>
<td>PCard</td>
<td>301</td>
<td>0.00</td>
<td>0.00</td>
<td>5000.00</td>
<td>5000.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>5000.00</td>
</tr>
<tr>
<td>5</td>
<td>EAGLE</td>
<td>68390</td>
<td>68390</td>
<td>Professional Independent Svcs</td>
<td>301</td>
<td>0.00</td>
<td>0.00</td>
<td>18400.00</td>
<td>18400.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>18400.00</td>
</tr>
<tr>
<td>6</td>
<td>EAGLE</td>
<td>68730</td>
<td>68730</td>
<td>Supplies General</td>
<td>301</td>
<td>0.00</td>
<td>0.00</td>
<td>16900.00</td>
<td>16900.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>16900.00</td>
</tr>
<tr>
<td>7</td>
<td>EAGLE</td>
<td>68902</td>
<td>68902</td>
<td>Travel Domestic</td>
<td>301</td>
<td>0.00</td>
<td>0.00</td>
<td>3000.00</td>
<td>3000.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>3000.00</td>
</tr>
<tr>
<td>8</td>
<td>EAGLE</td>
<td>68903</td>
<td>68903</td>
<td>Travel Foreign</td>
<td>301</td>
<td>0.00</td>
<td>0.00</td>
<td>3000.00</td>
<td>3000.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>3000.00</td>
</tr>
</tbody>
</table>
Reminders

• **Budget Transfers**
  - Personalize Budget Lines
  - New Fiscal Year – Change Journal Date to first day of the Fiscal Year

  ![Budget Transfer Form](image)

• **Queries and Reports**
  - Keep your search criteria simple
  - Inquires are timing out – Report this to FMS (fms@bc.edu)
Helpful Hints

To save your query click Add to Favorites located in the far right in the search results.

To do additional research without losing your results click on New Window located in the top right corner below worklist.

To save your chartstring information to avoid entering each time, click Save Search Criteria ➔.
Happy Fiscal Year End!

www.bc.edu/offices/controller

Approvals – Wednesday, May 31st – 12:00pm
Shut Down – Wednesday, May 31st – 12:00pm
Scan/Hand deliver paperwork – Wednesday, May 31st – 3:00pm

*Remember – be aware of vacation schedules for approvals*